Model Analysis Using Statistical Screening: Extensions and Example Applications

Timothy R.B. Taylor\textsuperscript{2,*}, David N. Ford\textsuperscript{3}, and Andrew Ford\textsuperscript{4}

ABSTRACT

System dynamics models are often constructed to improve system performance by identifying and modifying feedback mechanisms that drive system behavior. Once identified, these feedback mechanisms can be used to design and test policies for system performance improvement. A preliminary step in developing policies is the identification of high leverage parameters and structures, the influential model sections that drive system behavior. The current work clarifies and extends the use of statistical screening (Ford and Flynn, 2005) as a model analysis tool with a six step process that identifies specific model sections for further analysis and development. The work also presents a method that clarifies the results of model analysis with statistical screening to practicing managers. Example application to three models, including the tipping point model (Taylor and Ford 2006, 2007) Bass diffusion (Sterman 2000), and World3 model (Meadows et al. 1974), illustrate the use of the tool and method. Statistical screening offers system dynamicists a user-friendly tool that can be used to help explain how model structure drives system behavior.

Keywords: Model analysis; Model development; Statistical screening; Tipping point

Introduction

System dynamicists focus on identifying feedback mechanisms within a system to offer explanations of system behavior (Forrester, 1961; Sterman, 2000). Once identified, these feedback mechanisms can be used to design and test policies for altering the system’s behavior. An efficient method for developing these policies is to focus on portions of the model that exert the greatest influence on the behavior of the variable or variables of interest, i.e. the high leverage parameters and structures. Changes in high leverage parameters and structures can shift feedback loop dominance and thereby dramatically alter system behavior.

Model analysis methods for identifying high leverage parameters and structures have seen increased attention from researchers in recent years. Ford (1999b) describes a behavioral model analysis, Mojtahedzadeh et al. (2004) describes the pathway participation method, and Kampmann and Oliva (2006) and Guneralp (2006) describe loop eigenvalue analysis. Here we illustrate the statistical screening\textsuperscript{5} approach to linking

\textsuperscript{1} An abbreviated version of this draft was submitted to the System Dynamics Review on February 14, 2007 for review for possible publication as a technical note.
\textsuperscript{2} PhD Candidate, Construction Engineering and Management Program, Zachry Department of Civil Engineering, Texas A&M University, College Station, TX 77843-3136. xftu@tamu.edu
\textsuperscript{3} Associate Professor, Construction Engineering and Management Program, Zachry Department of Civil Engineering, Texas A&M University, College Station, TX 77843-3136. davidford@tamu.edu
\textsuperscript{4} Professor, School of Earth and Environmental Sciences, Washington State University, Pullman, WA 99164-4430. FordA@mail.wsu.edu
\textsuperscript{*} Contact author
\textsuperscript{5} See Ford and Flynn (2005) for a comparison of statistical screening with pathway participation and loop eigenvalue analysis.
structure and behavior using the tipping point model developed by Taylor and Ford (2006, in press)\(^6\). The relevant portions of the tipping point model are shown in Figure 1.

\[\text{Figure 1: Feedback in a tipping point project model (Taylor and Ford 2006)}\]

The tipping point model simulates a single development project subject to feedback dynamics that can create both rework of original project scope and the addition of work to the project beyond the original scope through ripple effects. These dynamics can create two very different behavior modes for projects with the same feedback structure and very similar characteristics\(^7\). For example, Figures 2 – 4 each show the behavior of the percent of the project work completed over time for 200 individual projects simulated using the tipping point model. For all 600 simulations the values of 13 of the 14 model input parameters were selected from a uniform parameter value distribution with a range of ±20% of the base case value. The only difference among the simulations in Figures 2, 3, and 4 is the value of the final exogenous model parameter, the project deadline. The project deadline was 300 months for the simulations in Figure 2, 75 months for the simulations in Figure 3, and 130 months for the simulations in Figure 4. A late deadline allows all 200 projects to reach 100% complete (Figure 2), an early deadline prevents any of the projects from being completed (Figure 3), and an intermediate deadline allows some of the projects to reach 100% complete (Figure 4).

\(^6\) See Ford and Flynn (2005) and Appendices C and D for additional example applications.

\(^7\) A more detailed description of the dynamics that drive the behavior of the tipping point model are available in Appendix A. Additional information on the tipping point model equations, testing, and use is available in Taylor and Ford (2006).
Figure 2: Behavior of 200 simulated projects with deadline = month 300

Figure 3: Behavior of 200 simulated projects with deadline = month 75

Figure 4: Behavior of 200 simulated projects with deadline = month 130

Statistical screening examines model behavior to identify high leverage parameters that drive high leverage structures. Examining the behavior modes in Figures 2 – 4 reveals the project deadline as a high leverage parameter for project performance and the model structure driven by the project deadline as a potential high leverage model structure. Clearly this information would be valuable to the manager of such a project because a
bifurcation in the behavior mode of the percent complete could reflect project success or failure. **How can a modeler identify the project deadline and other variables as high leverage parameters in this model?**

Statistical screening (Ford and Flynn, 2005) offers a simple, structured, and user-friendly means of identifying high leverage model parameters. Statistical screening provides rich analysis results by quantifying parameter influence throughout a simulation, thereby describing the evolution of exogenous impacts on behavior. In addition, statistical screening provides modelers with the objective model analysis results required to generate clear behavior distinctions such as those shown in Figures 2 – 4. Statistical screening does this by allowing a modeler to simultaneously test many model parameters.

Recent work on statistical screening of system dynamics models by Ford and Flynn (2005) focuses on the influence of input parameter variance on behavior modes. They develop a method for performing statistical screening and provide example applications. The current work clarifies how statistical screening can also be used for model analysis by developing a formal method for using statistical screening to provide insight into how model structure drives system behavior. To illustrate its use, the method is applied to the tipping point model (Taylor and Ford, 2006), the Bass diffusion model (Sterman 2000) (Appendix C), and the World3 model (Meadows et al. 1974) (Appendix D). The work also demonstrates a presentation format that modelers can use to clearly describe to system managers how model structure drives system behavior.

**The Six Steps of Statistical Screening**

Statistical screening uses multiple simulations generated by varying model input parameters to calculate correlation coefficients that measure the direction and strength of the relationship between input parameters and a user defined system performance variable. Values of correlation coefficients vary between -1 and +1, with the polarity denoting the direction of impact in the same manner as casual link polarity. Parameters with correlation coefficients with a value of “1” are perfectly correlated with the performance variable, correlation coefficients of “0” indicate no correlation, and correlation coefficients of “-1” indicate a perfectly inverse correlation. The method calculates correlation coefficients for each time unit of the simulation for as many exogenous parameters as the user selects. This provides a time series of correlation coefficients for each selected exogenous variable (demonstrated next). The technical process of statistical screening analysis is described in Ford and Flynn (2005) and in Appendix B along with an example application.

High leverage parameters identified by statistical screening can be used to directly design policies; such as optimizing the performance variable. However, this does not purposefully exploit the power of system dynamics to use the system’s feedback structure to explain the behavior. A better use of statistical screening results links them to specific model structures that can then be further analyzed and potentially expanded to improve model validity. Several system dynamics texts (Forrester, 1961; Ford, 1999a; Sterman, 2000) discuss the importance of making high influence exogenous model parameters
endogenous as a means of improving system dynamics model validity. Statistical screening can provide a structured tool for this type of model growth and improvement.

The six steps of statistical screening (SoS) described next are tools to guide and assist model investigation. They are not rigidly prescriptive. Nor do they cover all conditions and cases. As will be shown, their use requires interpretation and judgment. With these conditions in mind, the following six step process can be used to apply statistical screening to model analysis and development.

1. Select a specific set of exogenous model parameters and a performance variable for analysis.
2. Perform statistical screening of the model to calculate correlation coefficients for the selected exogenous model parameters as described in Ford and Flynn (2005) (see Appendix B). Plot the correlation coefficient time series in one graph and the behavior of the performance variable for all simulations in a second graph.
3. Select a time period for analysis by examining time series of the performance parameter and the correlation coefficients.
4. Identify the high influence parameter(s) during the selected time period as those with the highest magnitude correlation coefficient values.
5. Identify high leverage model structures as those that are directly driven by the high influence parameter(s) identified in step 4 and impact the performance parameter.
6. Use additional structure-behavior analysis methods (e.g. verbal reasoning, scenario analysis, behavioral analysis, etc.) to explain how the high leverage model structures identified in step 5 drive behavior.

If improved model validity is desired, the modeler can expand high leverage model structures and make exogenous high leverage parameters endogenous.

An Example Application: the Tipping Point Model

Step 1: Select Parameters and Performance Variable
All fourteen model input parameters for the tipping point model were analyzed. “Percent complete” was selected as the performance variable.

Step 2: Perform Statistical Screening to Generate Correlation Coefficients
The fourteen model input parameters selected in step 1 were varied uniformly ± 20% from base case values. Data from the 200 simulations was downloaded into Excel® and

---

8 The analysis of the Taylor and Ford (2006) tipping point model is an example of analyzing what the authors consider a medium level complexity model. For an example of analyzing a simple model (Bass diffusion) see Appendix C. For an example of analyzing a relatively complex model (World3) see Appendix D.

9 For large models with many exogenous inputs the modeler may need to analyze several subsets of parameters and use their judgment when selecting input parameters for analysis. See Ford (1990) for an example of developing a process to select relevant parameters for analysis.

10 The variation in parameter value of ±20% is selected to simplify the illustration of the method. Modelers should assign uncertainty to input parameter values that reflect the uncertainty in the actual system. See Ford (1990) for an example.
the correlations coefficients tabulated using the Excel® template described in Ford and Flynn (2005) and available at http://www.wsu.edu/~forda/CCTemplate. Figure 5 shows the time series of the correlation coefficients of the four parameters with the highest magnitude correlation coefficient values and therefore the highest leverage on percent complete. The shaded region of Figure 5 represents the threshold value\textsuperscript{11} for correlation coefficients, below which the value is assumed to be zero. Percent complete behavior for the same set of simulations is shown in Figure 4.

![Figure 5: Statistical screening of the tipping point model](image)

**Step 3: Select Analysis Time Period**
As previously described, a project manager might be interested in the bifurcation of the project’s percent complete. This occurs in the period between months 80 and 200 (Figure 4). Therefore the period 80 - 200 was selected for analysis.

**Step 4: Identify High Magnitude Correlation Coefficients**
Between months 80 – 200 the parameter “project deadline” has the highest influence on percent complete as evidenced by it having the highest magnitude correlation coefficient value over the time period.

**Step 5: Connect High Magnitude Correlation Coefficients with Model Structure**
An examination of Figure 1 shows the parameter “project deadline,” which is identified as a high leverage model structure between months 80 – 200, directly impacts the schedule pressure loop (R2).

\textsuperscript{11} The threshold range of [-0.2, 0.2] was selected based on the observed correlation coefficient value of dummy variables not connected to the model structure. This threshold range is supported by Table A 11(i): “The 10%, 5%, 2%, and 1% Two-Tailed Significance Levels of the Correlation Coefficient” in Snedecor and Cochran (1980) and Table V.A.: “Values of the Correlation Coefficient for Different Levels of Significance” in Fisher (1954) for a 95% confidence level and 200 samples.
Step 6: Additional Analysis

Manual feedback loop analysis is chosen here to link structure and behavior. The schedule pressure loop (R2) impacts percent complete by altering the level of rework on a project. The “fraction of work requiring change” determines how much work is completed correctly and released or completed incorrectly and must be reworked (and add work to the project backlog due to ripple effects). Schedule pressure can increase the amount of rework on a project by increasing the “fraction of work requiring change.” Increasing the value of the “fraction of work requiring change” strengthens the ripple effect loop (R1) and weakens the project progress loop (B1). The relative strengths of loops B1 and R1 can dramatically alter project percent complete. This is because, if the “fraction of work requiring change” increases past the tipping point, the model’s feedback loop dominance shifts from the project progress loop (B1) to the ripple effect loop (R1) and the percent complete switches from steadily increasing to steadily decreasing (Figure 4). The negative impact of schedule pressure as described here is consistent with the results of Nepal et al. (2006).

The feedback simplicity of the core of the tipping point model provides the basis for a clear example of the application of the six steps of statistical screening. With additional judgments the steps can be applied to larger and more complex models.

Clarifying Statistical Screening Results

The statistical screening results shown in Figure 5 paint a dynamic picture of how parameters in the tipping point model influence the behavior of a simulated project. However, the concept of a correlation coefficient is somewhat abstract and may not be easily or universally understood by practicing managers. In addition, the explanation of performance offered by verbal reasoning (step 6) may not be clear to a manager that is unfamiliar with system feedback. This challenges the system dynamicist to present the impact of high leverage parameters (e.g. project deadline), and subsequently the high leverage structures (e.g. the schedule pressure feedback mechanism), on performance in a manner that can be clearly understood by a manager.

One solution to this issue demonstrated by McKay et al. (1999) is to use the behavior mode traces of multiple project simulations to illustrate the importance of high leverage parameters on performance instead of correlation coefficients. Using the six step process presented here and the tipping point model example the modeler could identify the project deadline and schedule pressure as key drivers of percent complete. The modeler

---

12 The final step of the six step process is where the modeler is required to exercise most of their judgment in analyzing the behavior of the system. Verbal reasoning is used here. This judgment can be reinforced by applying other, potentially more rigorous analysis methods.

13 The verbal reasoning analysis presented here is supported by the results of behavioral analysis (Ford 1999b) of the tipping point model. See Taylor et al. (2005) for details on the behavioral analysis of the tipping point model.

14 Performing the six step statistical screening process on the tipping point model took the author approximately 30 minutes. Analysis times will vary depending upon several factors including model complexity and user experience.
could then illustrate the importance of the project deadline and schedule pressure to the project manager by showing Figures 2 – 4 to the project manager. Figures 2 – 4 illustrate that, regardless of variation in the 13 other model parameters within their ± 20% range, a change in the project deadline (and therefore a change in the amount of schedule pressure) can dramatically alter the performance of a project. This presents the results of the analysis in a form that the project manager is familiar with, project progress as tracked by percent complete. This makes clear how an overly aggressive deadline (Figure 3) can lead to poor project performance while a more relaxed deadline (Figure 2) can reduce the chance of project failure due to schedule pressure. The project manager could use this information when setting a project deadline to manage the risk of schedule pressure on the project.

**Discussion and Conclusions**

The current work extends and clarifies the use of statistical screening as a model analysis tool by presenting a six step process for using statistical screening to provide insight into how model structure drives system behavior. The process was demonstrated by analyzing the bifurcated behavior produced by the tipping point model (Taylor and Ford, 2006). The process has also been used to analyze the Bass diffusion model (Appendix C) and the World3 model (Appendix D) and returned useful results. The process facilitates improved model understanding by providing a structured method to analyze multiple model parameters over the course of a simulation. The results of the analysis can serve as a stepping off point for additional analysis methods and model development.

The current work also suggests a presentation method that makes clear the results of statistical screening analysis to system managers. The same method has proven useful in discussion of the land use policies that influence Sage-grouse populations in central Washington (Beall et al., 2006). This presentation method allowed the Sage-grouse team to more easily explain how the ecological system affected the population of Sage-grouse to wildlife management professionals. The advantage offered by this presentation method may be applicable to any model in which changing the value of a single parameter causes a dramatic change in the behavior mode of a system performance variable.

Statistical screening’s simple-to-use-and-understand format make it potentially very useful to system dynamics modelers. When used in conjunction with the process described here statistical screening offers an easy and objective method to efficiently identify high leverage model parameters and structures. This information can then be used to improve model understanding and to grow and improve system dynamics models.

**References**


Appendix A: Tipping Point Model (Taylor and Ford 2006)

The tipping point model used to demonstrate the six steps of statistical screening is described in Taylor and Ford (2006, in press). The tipping point model is useful for demonstrating the six steps of statistical screening because the model is relatively simple, the basic structure of the model has been well established (Cooper 1993; Ford and Sterman 2003a,b; Joglekar and Ford 2005; Taylor and Ford 2006; Lee et al. 2007 among others), and the model is capable of producing two unambiguous behavior modes. The ability to produce two unambiguous behavior modes is particularly useful in demonstrating the results presentation method described by McKay et al (1999).

The tipping point model is purposefully simple relative to actual practice to expose the relationships between tipping point structures, project behavior modes, and management. Therefore, although many development processes and features of project participants interact to determine project performance, only those features that describe a particular tipping point structure, project management policies, and the fundamental processes they impact are included. For example, resource productivities are assumed fixed, work backlogs are assumed to be available for development, and the model assumes that work packages are completed in accordance with schedule requirements (i.e. work packages on the critical path are completed first) but does not identify specific critical path work packages. The literature cited above investigates the impacts of these and other factors influencing performance. The complete model with documentation is also available from the authors or at http://ceprofs.tamu.edu/dford/.

The model consists of three sectors: a workflow sector (Figure A-1), a resource allocation sector, and a schedule pressure sector. The workflow sector is based on Ford and Sterman’s (1998) structure of a development project value chain with a rework cycle. The same or similar structures have been used extensively to investigate project dynamics and management issues (e.g. Cooper 1993, 1994; Ford and Sterman, 2003a,b; Joglekar and Ford 2005; Lee et al. 2005; Lee et al. 2007). Work is initially completed and moves from the initial completion backlog (IC backlog) to the backlog of work requiring quality assurance (QA backlog). Work that passes quality assurance is approved and adds to the stock of work that has been approved and released (Work Released). Work discovered to require change (either through errors, omissions, or regulation changes) moves into the backlog of work known to require rework (RW Backlog). The IC backlog can also be increased by work created by ripple effects. The strength of ripple effects describes the interdependence of project work packages. Completing rework returns work packages to the QA backlog for checking again because rework can reveal previously hidden, or create new rework requirements. The initial completion, quality assurance, and rework flows are constrained by either development processes or available resources. Resources are allocated to the three development activities proportional to demand in the resource allocation sector. Each proportion is the size of the activity’s backlog compared to the project backlog (IC backlog + QA backlog + Rework backlog).
The feedback loops shown in Figure A-1 can explain tipping point dynamics. Balancing feedback loop B1 (Project Progress) withdraws work from the rework cycle. The QA backlog increases due to initial completion and rework, causing the QA rate to increase as resources are shifted to quality assurance. This increases the work approval rate, reducing the QA backlog and increasing the work released stock. This balancing loop drives the project to completion as the backlogs that represent the remaining project work decline to zero. In the absence of ripple effects, B1 completes a project as quickly as processes and resources allow. Reinforcing loop R1 (Ripple Effect) adds work to the project through the discovery of rework and ripple effects. Increasing the QA backlog increases the QA rate, increasing the rate at which work is discovered to require rework. This increases ripple effects, adding work to the IC backlog. As the IC backlog increases resources are shifted to initial completion, the initial completion work rate increases, and the QA backlog increases further. In the absence of loop B1 (e.g. if all work required rework) loop R1 increases the rework and project backlog infinitely, thereby degrading project performance to eventual failure.

15 The model structure shown in Figure A-1 is a more detailed representation of the structure shown in Figure 1. The “project backlog” stock in Figure 1 is represented by the dashed box in Figure A-1.
Feedback loops B1 and R1 create a tipping point based on the approval and addition of work to the project backlog. As long as loop B1 dominates the project progresses (albeit perhaps very slowly), the total project backlog (represented by the dashed box in Figure A-1) decreases, and the percent complete increases. However, if loop R1 dominates, the project backlog increases and the percent complete decreases. At the tipping point the rate of work being added to and the rate of work being removed from the project backlog are equal. When work is being completed faster then new work is being added (ripple effect rate < approve work rate) the percent complete increases. When work is being added faster then it is being completed (ripple effect rate > approve work rate) the percent complete decreases.

A third feedback loop is needed to endogenously shift feedback loop dominance between loops B1 and R1. Schedule pressure can create this third feedback loop. Schedule pressure is a common side effect of development projects that can lower development quality (Park et al. 2004; Nepal et al. 2006), increase rework (Cooper 1994; Graham 2000; Ford and Sterman 2003b; Nepal et al. 2006), and thereby have important impacts on performance. Schedule pressure can also have beneficial impacts which can be modeled with additional feedback loops (see Ford 1995 for examples), but the current work models only the net effects of schedule pressure which are assumed to be negative. This assumption is supported by the findings of Nepal et al. (2006). Schedule pressure increases with the time required to complete the project backlog and decreases with the time available to complete the project backlog. As a project approaches a deadline, schedule pressure increases (ceteris paribus) and developers increase the pace of work to meet the deadline. This increases the risk of work being completed incorrectly (i.e. increases the fraction of work requiring rework). Therefore, reinforcing Loop R2 (Schedule Pressure) can increase the strength of the ripple effect loop (R1) by increasing the rework fraction. The resulting increase in ripple effects, the IC backlog, and thereby the project’s backlog increases the time required to complete the project, increasing schedule pressure further. Through loop R2 schedule pressure can push a project initially dominated by the Project Progress loop (B1) across its tipping point into dominance by the Ripple Effect loop (R1) and toward failure.
Appendix B: Statistical Screening
Statistical screening (step 2 of the six step process) can be performed as follows:

2-A. Select uncertain model input parameters and a single performance variable for analysis.

2-B. Specify a distribution (e.g. uniform with maximum and minimum values) for each uncertain model input identified in step 1.

2-C. Simulate using combinations of values from the distributions specified in step 2. For example, Vensim’s® “Partial Simulation Tool” can be used to perform a Latin Hypercube sampling of values. Save the analysis results, for example in a Vensim® “Sensitivity Save List” file.

2-D. Export the results of the analysis performed in step 3 to an Excell® spreadsheet, such as by saving to a .tab file using Vensim’s® “Export Dataset” tool.

2-E. Download one of the available Excel® templates from http://www.wsu.edu/~forda/CCTemplate.16

2-F. Import the data saved in step 4 to the selected Excel® template. Once the data is imported into the Excel® template click on the worksheet tab “CC Graph” to view the correlation coefficients for the model analysis.

Example Application
An example of the technical process for calculating correlation coefficients using Vensim and Excel as outlined in Appendix B is shown here. For this example the tipping point model described in Appendix A is analyzed.

Steps 2A and 2B: Select uncertain model parameters and uncertainty
The fourteen model input parameters for the tipping point model were selected as uncertain model inputs. The parameters and their associated uncertainty ranges are shown in Table B-1. The performance variable selected for the analysis was percent complete.

---

16 The templates are file named by the (number of uncertain inputs)x(the number of simulations)x(the number of save periods). For example, “CC template 6x50x20.xls” is a template that can be used for 6 uncertain model inputs, 50 separate simulations, and 20 save periods. Depending upon the number of inputs, simulations, and save periods, analysis of a particular model may require simple modification to the structure of one of the basic Excel® template.
Table B-1: Exogenous parameters in the tipping point model and their ranges

<table>
<thead>
<tr>
<th>Exogenous Variable</th>
<th>Range</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>base frac disc to require rework</td>
<td>[0.24, 0.36]</td>
<td>Uniform</td>
</tr>
<tr>
<td>base ripple effect strength</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>project deadline</td>
<td>[240, 360]</td>
<td>Uniform</td>
</tr>
<tr>
<td>scope initial</td>
<td>[28000, 42000]</td>
<td>Uniform</td>
</tr>
<tr>
<td>sensitivity to schedule pressure</td>
<td>[0.32, 0.48]</td>
<td>Uniform</td>
</tr>
<tr>
<td>total staff</td>
<td>[1200, 1800]</td>
<td>Uniform</td>
</tr>
<tr>
<td>staff adjustment time</td>
<td>[3.2, 4.8]</td>
<td>Uniform</td>
</tr>
<tr>
<td>IC staff productivity</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>RW staff productivity</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>QA staff productivity</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>minimum IC duration</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>minimum RW duration</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>minimum QA duration</td>
<td>[0.8, 1.2]</td>
<td>Uniform</td>
</tr>
<tr>
<td>release productivity adjustment</td>
<td>[0.4, 0.6]</td>
<td>Uniform</td>
</tr>
</tbody>
</table>

Step 2-C: Generate multiple simulations

Vensim’s® “Sensitivity Simulation” tool (located under “Model” > “Partial Simulation” > “Sensitivity” in the Vensim® main tool bar) can be used to simulate this uncertainty in the tipping point model. Figure B-1 shows the “setup” window for assigning ranges of uncertainty (note these are the same variable and uncertainty ranges shown in Table B-1). We ask for 200 simulations, using Latin Hypercube Sampling (LHS) to select the values of the 14 inputs in each of the 200 runs. We assign the uniform random distribution to all inputs. We ask Vensim® to store the results of the 200 runs in the .vsc file named at the top of the window. Clicking on “OK” prompts Vensim® to ask for a .lst file, a file with a list of variables to be saved (Figure B-2). The .lst file should also contain the names of the 14 variables listed in Table B-1 as well as the performance variable percent complete.
Once the .vsc and .lst files are loaded enter the name of the .vdf file in the “run name” box shown in Figure B-3 to store the results of the sensitivity analysis and click the “sensitivity” button to run the analysis.
Step 2-D: Export multiple simulation data

Once the sensitivity runs are completed click on “Model” > “Export Data Set” on the Vensim® main tool bar. Vensim® will prompt for the .vdf file to export. We select the file from our sensitivity simulation (TippingPoint.vdf) and the box shown in Figure B-4 will appear. Enter a .tab file name into the “Export to . . .” box as shown in Figure B-4. Once the .tab file is named click the “OK” button to export the results to the .tab file.

Step 2-E and 2-F: Calculate correlation coefficients

To calculate the correlation coefficients, we export the 200 simulations to a spreadsheet template designed to receive the values assigned to 14 uncertain inputs in the 200 simulations with results for the key output saved in 200 time periods. This is a modified spreadsheet from one of several templates (see B-2) that may be downloaded from http://www.wsu.edu/~forda/CTemplate.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Sensitivity Results for</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC Template 6x50x20.xls</td>
<td>6 uncertain inputs; 50 runs; 20 save periods</td>
</tr>
<tr>
<td>CC Template 6x50x40.xls</td>
<td>6 uncertain inputs; 50 runs; 40 save periods</td>
</tr>
<tr>
<td>CC Template 14x50x40.xls</td>
<td>14 uncertain inputs; 50 runs; 40 save periods</td>
</tr>
</tbody>
</table>
Once the selected spreadsheet is open we click on “Data” > “Import External Data” > “Import Data” as shown in Figure B-5. Once the “Select Data Source” box opens, we select the TippingPoint.tab file created in step 4. When the file is opened the spreadsheet will open the “Text Import Wizard.” At this stage, we click on next, click on next again, then finish, and agree to have the data go to cell $A$3 (The green cell highlighted in the spreadsheet). The results of the sensitivity analysis will appear in the boxed cells, and the time graphs of the correlation coefficients will on the worksheet tab “CC Graph.” The CC Graph for the tipping point analysis performed here is similar to the plot shown in Figure 5.

Figure B-5: Importing .tab data into Excel®
Appendix C: Analysis of the Bass Diffusion Model

This appendix presents the Bass diffusion model (Figure C-1) analysis results. For a full description of the model see Sterman (2000).

The adoption rate equation is:

\[
\text{adoption rate} = \text{contact rate} \times \text{adoption fraction} \times \text{potential adopters} \times \left[ \frac{\text{adopters}}{\text{total population}} \right]
\]

Step 1: Select Parameters and Performance Variable

All four model input parameters for the Bass diffusion model were analyzed (Table C-1). “adoptors” was selected as the performance variable.

<table>
<thead>
<tr>
<th>Exogenous Variable</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>initial potential adopters</td>
<td>[495, 1485]</td>
</tr>
<tr>
<td>initial adopters</td>
<td>[5, 15]</td>
</tr>
<tr>
<td>contact rate</td>
<td>[0.25, 0.75]</td>
</tr>
<tr>
<td>adoption fraction</td>
<td>[0.25, 0.75]</td>
</tr>
</tbody>
</table>

Step 2: Perform Statistical Screening to Generate Correlation Coefficients

The four model input parameters selected in step 1 were varied uniformly \( \pm 50\% \) from base case values\(^{17}\). Data from the 200 simulations was downloaded into Excel\(^{\circledR} \) and the correlations coefficients tabulated using the Excel\(^{\circledR} \) template described in Ford and Flynn (2005) and available at http://www.wsu.edu/~forda/CCTemplate. The number of adopters for each of the 200 simulations is shown in Figure C-2. Figure C-3 shows the time series of the correlation coefficients of the four parameters. The shaded region of Figure C-3

---

\(^{17}\) The variation in parameter value of \( \pm 50\% \) is selected to simplify the illustration of the method. Modelers should assign uncertainty to input parameter values that reflect the uncertainty in the actual system. See Ford (1990) for an example.
represents the threshold value\textsuperscript{18} for correlation coefficients, below which the value is assumed to be zero.

\begin{figure}
\centering
\includegraphics[width=\textwidth]{adopters.png}
\caption{Adopters for 200 simulations}
\end{figure}

\textsuperscript{18} The threshold range of \([-0.2, 0.2]\) was selected based on the observed correlation coefficient value of dummy variables not connected to the model structure. This threshold range is supported by Table A 11(i): “The 10%, 5%, 2%, and 1% Two-Tailed Significance Levels of the Correlation Coefficient” in Snedecor and Cochran (1980) and Table V.A.: “Values of the Correlation Coefficient for Different Levels of Significance” in Fisher (1954) for a 95% confidence level and 200 samples.
Step 3: Select Analysis Time Period
Suppose you are interested in why the number of adopters of a new product peaks after a couple of years. Therefore you select months 35 – 100 for your analysis period.

Step 4: Identify High Magnitude Correlation Coefficients
Between months 35 – 100 the parameter “initial potential adopters” has the highest influence on the number of adopters of the new product as evidenced by it having the highest magnitude correlation coefficient value over the time period.

Step 5: Connect High Magnitude Correlation Coefficients with Model Structure
An examination of Figure C-1 shows the parameter “initial potential adopters,” which is identified as a high leverage model structure between months 35 – 100, directly impacts the variable “total population.”

Step 6: Additional Analysis
Verbal reasoning is used to link structure and behavior. Figure C-1 shows that the number of adopters is increased or decreased by the adoption rate. Since the number of adopters in Figure C-2 begins to level off somewhere between months 25-50 for most of the 200 simulations the adoption rate during this time must approach zero. The high leverage parameter “initial potential adopters”\textsuperscript{19} impacts the adoption rate through the total population and the number of potential adopters by constraining the adoption rate

\textsuperscript{19} The presentation method described by McKay et al. (1999) and presented earlier in this work is not used to present the results of the Bass Diffusion model because the Bass Diffusion model produces a single behavior mode (S-shaped growth). The McKay et al. (1999) presentation method is most effective when a model produces two or more unambiguous behavior modes.
through the balancing feedback loop. The total population remains constant throughout the course of the simulation and therefore cannot cause the adoption rate to approach zero during a simulation. The number of potential adopters does change throughout the course of the simulation. As the simulation progressed the number of potential adopters decreases until the stock is emptied. At this point, there are no potential adopters left to acquire the new product. Therefore, the adoption rate approaches zero after a number of years and the number of product adopters levels off.
Appendix D: Analysis of the World3 Model

This appendix presents the statistical screening analysis results of the World3 model. The World3 model used for this analysis is the “WRLD3-03” sample model available in Vensim. The reference behavior mode analyzed here is the “reference run” described on pages 499-502 of Meadows et al (1974). The World3 model is comprised of five model sectors (Figure D-1) population, capital, agriculture, nonrenewable resources, and persistent pollution (Meadows et al. 1974). The reference behavior mode is shown in Figure D-2. A more detailed description of the World3 model is available in Meadows et al. (1972), Meadows and Meadows (1973), and Meadows et al. (1974).

Figure D-1: Interactions between sectors in the World3 model

---

20 This diagram is Figure 1-2 on page 11 of *Dynamics of Growth in a Finite World* by Meadows et al. (1974).
Step 1: Select Parameters and Performance Variable
The World3 model has 72 exogenous model parameters that can reasonably be uncertain. All 72 parameters were analyzed using statistical screening. The correlation coefficients for 64 parameters were located between -0.1 and 0.1 and were thus deemed insignificant in the explanation of the system’s behavior\(^{21}\). The analysis of the other eight parameters is shown in Table D-1. “Population” was selected as the performance variable.

Table D-1: Exogenous World3 parameters and their range

<table>
<thead>
<tr>
<th>Exogenous Variable</th>
<th>Range</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>average life of industrial capital 1</td>
<td>[12.6, 15.4]</td>
<td>Uniform</td>
</tr>
<tr>
<td>desired completed family size normal</td>
<td>[3.42, 4.18]</td>
<td>Uniform</td>
</tr>
<tr>
<td>fraction of industrial output allocated to consumption constant 1</td>
<td>[0.39, 0.47]</td>
<td>Uniform</td>
</tr>
<tr>
<td>industrial capital output ratio 1</td>
<td>[2.7, 3.3]</td>
<td>Uniform</td>
</tr>
<tr>
<td>initial population 0 to 14</td>
<td>[5.85, 7.15]*</td>
<td>Uniform</td>
</tr>
<tr>
<td>initial population 15 to 44</td>
<td>[6.3, 7.7]*</td>
<td>Uniform</td>
</tr>
<tr>
<td>life expectancy normal</td>
<td>[25.2, 30.8]</td>
<td>Uniform</td>
</tr>
<tr>
<td>reproductive lifetime</td>
<td>[27, 23]</td>
<td>Uniform</td>
</tr>
</tbody>
</table>

\(^*\) in 100,000,000 of people

Step 2: Perform Statistical Screening to Generate Correlation Coefficients
The eight model input parameters selected in step 1 were varied uniformly \(\pm 10\%\) from reference run values\(^{22}\). Data from the 1,000 simulations was downloaded into Excel\(^{\circledR}\) and the correlation coefficients tabulated using the Excel\(^{\circledR}\) template described in Ford and

---

\(^{21}\) The threshold range of \([-0.1, 0.1]\) is supported by Table A 11(i): “The 10%, 5%, 2%, and 1% Two-Tailed Significance Levels of the Correlation Coefficient” in Snedecor and Cochran (1980) and Table V.A.: “Values of the Correlation Coefficient for Different Levels of Significance” in Fisher (1954) for a 95% confidence level and 1,000 samples.

\(^{22}\) The variation in parameter value of 10% is selected to simplify the illustration of the method. Modelers should assign uncertainty to input parameter values that reflect the uncertainty in the actual system. See Ford (1990) for an example.
Flynn (2005) and available at http://www.wsu.edu/~forda/CCTemplate. The human population behavior for 100 of the 1,000 simulations is shown in Figure D-3 (others not shown for clarity). Figure D-4 shows the time series of the correlation coefficients of the eight parameters. The shaded region of represents the threshold value for correlation coefficients, below which the value is assumed to be zero.

Figure D-3: Human population simulations (100 of 1,000 simulations)

Figure D-4: Correlation coefficients for eight parameters in the World3 model

---

23 The correlation coefficient graph shown in Figure D-4 is nearly identical to the results of a similar analysis of the World3 model performed by Ford and Flynn (2005), Figure 16.
Step 3: Select Analysis Time Period
The years 2025 – 2100 were selected as the analysis period to investigate the decline in population (Figure D-2) that occurs during the second half of the simulation.

Step 4: Identify High Magnitude Correlation Coefficients
Between years 2025 – 2100 the parameters “reproductive lifetime,” “desired completed family size normal,” “fraction of industrial output allocated to consumption constant 1,” and “industrial capital output ratio 1” have the highest influence on the population as evidenced their highest magnitude correlation coefficients over the analysis period.

Step 5: Connect High Magnitude Correlation Coefficients with Model Structure
The parameters “reproductive lifetime” (RL) and “desired completed family size normal” (DCFN) are contained in the population model sector. The reproductive lifetime is used to determine the birth rate (Meadows et al. 1974).

The parameters “fraction of industrial output allocated to consumption constant 1” (FIOAC1) and “industrial capital output ratio 1” (ICOR1) are contained in the capital model sector. The fraction of industrial output allocated to consumption constant 1 is used to determine the reinvestment of capital back into industrial activities. The industrial capital output ratio 1 is one of the parameters used to determine industrial output.

Step 6: Additional Analysis
To evaluate statistical screening as a model analysis tool the results of the screening analysis of the reference behavior mode (Figure D-2) is compared with the analysis reference case analysis described in Meadows et al. (1974) who noted, “Population and capital growth grow past their sustainable physical limits and then return to a pre-industrial level of development. Growth is halted in this run through the effects of nonrenewable resource depletion” (Meadows et al. 1974, p. 500). This explanation appears to contradict the statistical screening results (Figure D-4) since the parameter “initial nonrenewable resources” was not found to be significant during the simulation.

Verbal reasoning and structural analysis is used to link structure and behavior. The performance variable population can be directly impacted by several sections of the model. A dramatic increase in birth rate or death rate will, over time, greatly increase or decrease the population. The parameters RL and DCFN are located in the same model sector as the performance variable and are closely linked to its performance by impacting the birth rate. The DCFN reflects how society views the “ideal” family size. The larger the desired family size (ceteris paribus) the greater the population. This is reflected by the positive correlation coefficient for the DCFN (Figure D-4) during the analysis period.

The parameter RL reflects the number of years that females are able to reproduce. This parameter is directly and positively linked to the birth rate. To understand how this
parameter impacts the birth rate it is necessary to look at how the parameter is used in the World3 model. The model equation\textsuperscript{24} for births is:

\[
\text{births} = \frac{\text{total fertility} \times \text{population 15 to 44} \times 0.5}{\text{reproductive lifetime}}
\]

where:

- \text{births} = \text{births per year [person/year]}
- \text{total fertility} = \text{total fertility [dimensionless]}
- \text{population 15 to 44} = \text{population, age 15-44 [person]}
- \text{reproductive lifetime} = \text{number of years a female can give birth [years]}

Given its location in the denominator of equation 30, the RL parameter regulates how quickly the population produces children. A higher RL value allows the population to space the birth of children farther apart. A lower RL value causes the population to wait a shorter period between child births. A lower RL will cause the population to grow more rapidly and overshoot sustainable levels. This is caused by the overshot population destroying capital and nonrenewable resources. This rapid population growth reduces the industrial output per capita (Figure D-5, Loop B-1). This reduces the capital available for consumption by increasing the capital required for reinvestment in industry (Figure D-5, Loop B2). This depletes the natural resources, thereby reducing industrial output (Figure D-5, Loop B3). This relationship is consistent with the negative correlation coefficient for IR in Figure D-3 during the analysis period.

The behavior of the parameters “fraction of industrial output allocated to consumption” (FIOAC1) and “industrial capital output ratio” (ICOR1) is particularly interesting. The evolution of the correlation coefficients for the two parameters is very similar throughout the entire simulation. At year 2025 the parameters are in the process of changing from a high magnitude negative correlation coefficient to a high magnitude positive correlation coefficient (Figure D-4). To understand how the FIOAC1 and ICOR1 impact the model it is necessary to examine the how the parameters are used in the surrounding model equations. A simplified view of one piece of the capital model structure is shown in Figure D-5. As shown in Figure D-1, feedback exists between the population and capital sectors. As described in Meadows et al. (1974) the feedback between these sectors drives the exponential growth in the population during the first 100 years of the simulation. This linkage allows us to analyze the impact of the parameters FIOAC1 and ICOR1 on the population by analyzing their impact on the capital sector, specifically the variable “industrial output per capita.”\textsuperscript{26}

---

\textsuperscript{24} Equation 30 disregards the population equilibrium function in the model that sets the birth rate = death rate at year 4,000. Since the simulation period is from the year 1900 to 2100 the population equilibrium function is not activated during the simulation. The births in equation 30 assumes the distribution of births is equal across the reproductive lifetime (i.e. from age 15 to 44). The 0.5 in equation 30 assumes that half the population between the ages of 15-44 are female (Meadows et al. 1974).

\textsuperscript{25} The equation number to the right of each equation (e.g. “30”) references the World3 model equation number in Meadows et al. (1974) Appendix A.

\textsuperscript{26} The variable “industrial output per capita” was selected because it is a key link between the capital sector and the population sector. See Meadows et al. (1974) for more detail.
Impact of FIOAC1 on Industrial Output per Capita
The FIOAC1 is one of the model parameters that sets the value of the variable “fraction of industrial output allocated to consumption constant” which is used to set the value of the “fraction of industrial output allocated to consumption.” The “fraction of industrial output allocated to consumption” is one of the parameters that determines the “fraction of industrial output allocated to investment:”

\[
\text{fraction of industrial output allocated to investment} = 1 - \text{fraction of industrial output allocated to agriculture} - \text{fraction of industrial output allocated to services} - \text{fraction of industrial output allocated to consumption}
\]

where:

- fraction of industrial output allocated to investment [dimensionless]
- fraction of industrial output allocated to agriculture [dimensionless]
- fraction of industrial output allocated to services [dimensionless]
- fraction of industrial output allocated to consumption [dimensionless]

Equation 56 shows that a higher fraction of industrial output allocated to consumption reduces the fraction of industrial capital allocated to investment. This reduces the industrial capital, which reduces the industrial output, and reduces the industrial output per capita (Figure D-5, Loop B2).
Impact of ICOR1 on Industrial Output per Capita
As with FIOCA1, the ICOR1 parameter impacts industrial output per capita. Where the FIOCA1 regulates the fraction of industrial capital invested in industrial output the ICOR1 meters the impact of nonrenewable resources on industrial output. This is better understood by examining the World3 model equation for the industrial output:

\[
\text{industrial output} = (((\text{industrial capital})) \times (1 - \text{fraction of industrial capital allocated to obtaining resources})) \times (\text{capacity utilization fraction}) / \text{industrial capital output ratio}
\]

where:
- industrial output [dollars/year]
- industrial capital [dollars]
- fraction of industrial capital allocated to obtaining resources [dimensionless]
- capacity utilization fraction [dimensionless]
- industrial capital output ratio [years]

As shown in Figure D-5 the parameter ICOR1 is used to calculate the industrial capital output ratio (ICOR). Equation 50 reveals that the ICOR regulates how fast industrial output changes due to changes in industrial capital, utilization, and nonrenewable resources. Thus, the ICOR partially regulates the rate at which the industrial output per capita changes.

A useful way to think about the impact of ICOR on the system and to resolve the apparent inconsistency between Meadows et al. (1974) analysis and the statistical screening results is to view the ICOR as sensitivity control for how the depletion of nonrenewable resources impacts industrial output (and ultimately the population). If industrial output was completely insensitive to the depletion of nonrenewable resources, nonrenewable resources could be completely depleted and industrial output and population would be unaffected. However, if industrial output was extremely sensitive to the depletion of nonrenewable resources, a small reduction in nonrenewable resources would dramatically reduce industrial output and population. Thus, the ICOR1 regulates the ability of nonrenewable resource depletion to impact industrial output and population. This reconciles the apparent contradiction between the statistical screening results presented in Figure D-4 and the conclusion of Meadows et al. (1974) that the depletion of nonrenewable resources causes the population to decline in the reference case (Figure D-2).

Discussion of Polarity Change for FIOAC1 and ICOR1 Correlation Coefficients.
One question raised by the World3 statistical screening analysis results is why the polarity of the correlation coefficients for the FIOAC1 and the ICOR1 change from negative to positive during the course of the simulation. One explanation for the polarity change is the overshoot of population above sustainable levels in the reference simulation as described in Meadows et al. (1974). Between the years 1900 to 2025 the correlation...
coefficients for the FIOAC1 and ICOR1 are negative. During this time smaller values of FIOAC1 and ICOR1 result in a larger population. As previously discussed the FIOAC1 and ICOR1 regulate the growth of industrial output. Thus, small values for these parameters allowed faster changes in the industrial output. This allowed the population to grow unconstrained by capital limitations during this time period.

However, as described in Meadows et al. (1974), eventually the exponential growth of the population reaches unsustainable levels the population growth is constrained by the resource sector. During this time (years 2025 – 2100) the correlation coefficients for the FIOAC1 and the ICOR1 are positive. Thus high values of FIOAC1 and ICOR1 result in higher populations. The high values of these parameters allow reduce the speed at which the depletion of nonrenewable resources can reduce the population.

Conclusions from the World3 Analysis
The World3 model analysis illustrates several points about statistical screening. First, the analysis illustrates the usefulness of the six step statistical screening analysis method in analyzing complex system dynamics models. The first author who performed the analysis had no knowledge of the structure, feedback dynamics, and results of the World3 model prior to the analysis. The World3 model has roughly 150 equations and over 600 pages of documentation (Meadows et al 1974). Yet, the six step process allowed that author to focus rather quickly on the industrial output/industrial capital feedback loop as a key driver of world population. Second, the results of the analysis are consistent with previously published model analysis (e.g. Meadows et al. 1974). And finally, the World3 analysis shows that although statistical screening is a useful tool to aid a system dynamicist in model analysis, the results require interpretation and thought by the user.

27 The first five steps of the six step statistical screening analysis process took approximately 10 hours to perform. The longer analysis time required as opposed to the tipping point model (30 minutes) is due to the time required to analyze all 72 uncertain model parameters.